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ABSTRACT
EXAMPLE BASED MACHINE TRANSLATION FROM ENGLISH
TO TURKISH WITH SYNCHRONOUS STRUCTURED STRINGTREE CORRESPONDENCE (SSTC)

N.Deniz ÖZTÜRK
M.S. in Computer Engineering
Supervisor: Assist. Prof. Dr. Çiğdem TURHAN
August, 2007

Example based machine translation is a translation method that uses previous
translations. Its system requires information built up with pre-translation of source
language and its corresponding equivalent in target language. With a new sentence entry
to system, method searches the translation part of corpus as a whole or as parts with
matching technique and collects the corresponding results in target language. Then,
these parts are aligned accordingly to grammatical rules of target language. In this work
uses tree search algorithm and methods for matching and alignment steps. This structure
provides great flexibility in many subjects.

Keywords: Example Based Machine Translation, Machine Learning, Synchronous
Structure String Tree (SSTC).
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ÖZET
İNGİLİZCEDEN TÜRKÇEYE SENKRONİZE YAPISAL SIRA AGAÇ YAPISI
İLE ÖRNEK TABANLI OTOMATİK ÇEVİRİ

N.Deniz ÖZTÜRK
Bilgisayar Mühendisliği, Yüksek Lisans
Tez Yöneticisi: Yard. Doç. Dr. Çiğdem TURHAN
Ağustos, 2007

Örnek tabanlı otomatik çeviri sistemleri daha önce yapılmış olan çevirileri
kullanan bir bir sistemdir. Sistem çeviri yapmak için kaynak dil ile ona karşılık gelen
hedef dil cümlelerinden oluşan bilgi birikiminden faydalanılır. Sistem çeviri yapacağı
yeni cümleyi hedef dilin bulunduğu veritabanında bütün ya da parçalar halinde arayarak
uygun bölümlerini ve ona karşılık gelen hedef dildeki sonuçlarını hafızaya alır. Daha
sonra karşılık gelen parçaları uygun şekilde birleştirip hedef dil yapısına göre düzenler.
Bu çalışmada veritatabanı oluşturmak için yapısal ağaç yapısını kullanmaktadır. Bu yapı
birçok konuda esneklik sağlamaktadır.

Anahtar Sözcükler : Örnek Tabanlı Otomatik Çeviri, Otomatik Öğrenme, Senkronize
Yapısal Sıra Agaç Yapısı.
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CHAPTER I

INTRODUCTION

Machine translation (MT) is a sub-field of computational linguistics that tries to
translate text or speech from one natural language to another with computer software.
MT attempts to automate all, or part of the process of translating from one human
language to another [1].
When it was first introduced, MT was an unthinkable goal; but today a number of
systems exist which produce output meaningful translations in a number of specific
domains. In the MT sector, “European Association for Machine Translation (EAMT)" is
the organization that serves people that are interested in MT and translation tools [2].
1.1 Why MT Matters
MT is an important topic, socially, politically, commercially, scientifically, and
philosophically and its importance is likely to increase in the future [1]. The social or
political importance of MT appears most in communities where more than one language
is generally spoken, for example the European Union. Translation is necessary for
communication and gathering information. There are few human translators, and there is
a limit on the amount of translation that can be performed without automation.
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Following factors give the commercial importance of MT. First of all, translation itself is
commercially important because, when someone is choosing a product he must select
between products including instruction manual written in his mother language, or
manual written in English. If the first case is true, the chance of using the new product
effectively will be higher. Additionally, translation is expensive. Translation is a high
skilled job, requiring much more than knowledge of the given languages. Moreover, loss
of time during translation is costly. Finally, world wide usage of the Internet forces us to
translate a document on the web between different languages in a time and cost effective
manner.
Scientifically, MT is an application area which is a testing ground for many ideas
in Computer Science, Artificial Intelligence, and Linguistics. Some of the most
important developments in these fields have begun in MT. Philosophically; MT shows
an attempt to automate an activity that requires human knowledge. Improved output
quality can also be achieved by human intervention: for example, some systems can
translate more accurately if the user has unambiguously identified which words in the
text are names. MT has proven to be useful as a tool to assist human translators and in
some cases can even produce output that can be used "as is".
1.2 Thesis Outline
In this thesis, the Example Based Machine Translation (EBMT) method is used
to produce translations from English to Turkish language. The bilingual corpus is used
on MS Office help documents. Thesis proposes a structure tree to store the corpora. In
the next chapter, a summary about MT is given and in Chapter 3, the EBMT system is
explained. Chapter 4, gives the details of the SSTC and in Chapter 5 the design and
implementation information for the ORHUN system architecture along with the
evaluation results of the performance of the system is provided. The thesis ends with
Conclusion and Future Work in Chapter 6.
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CHAPTER II

MACHINE TRANSLATION

Machine Translation (MT) is a branch of computational linguistics that researches
on the use of computer software to translate text or speech from one natural language to
another. Simple MT systems generate a translation by performing basic substitution of
words in source language to target language. More complex translations can be
attempted by sign corpus techniques; these techniques give better results for the
differences in linguistic typology, phrase recognition, and translation of idioms [3].
There are many reasons to use MT. The first reason is the speed of translation as
MT tools translate much quicker than humans. In addition, computers can make similar
translation continuously; however, human translators require variety; for example:
technical materials may become too boring for human translators. Sometimes human
translation is not needed at all, as required quality in translation may be low. In such
situations MT would be best solution as computers do not produce good translations.
Plus, translation cost can be lowered with MT.
2.1 History of MT
The research on MT started when Warren Weaver wrote a paper on using
computers for translation in July 1949 [4]. Later a group of scientist held a conference
on MT in 1952. The first translation system was shown in Jan.1954 [4].
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A few years later a system was installed by IBM at the US Air Force in 1959,
and in 1963 and 1964, Georgetown University, installed systems at Euratom and at the
US Atomic Energy Agency. In the mid 1950’s Russia started its MT research [4].
The Systran system was started at the US Air Force in 1970, which translated
Russian to English. The Météo system for translating weather forecasts was started in
Canada in 1976 [5], which was later bought by The European Commission Systran
system. Japanese companies began the production of commercial systems in the 1980’s
and the first translator workstations were put up for sale in 1990. Nowadays, MT has
become an online service on the Internet [5].
Some examples of MT products are [6]:
1

Systran (http://babelfish.altavista.com/)

2

Comprendium (based on Metal)

3

ProMT (http://www.translate.ru/eng)

4

ESTeam (memory-based)

5

http://ourworld.compuserve.com/homepages/WJHutchins/Compendium-4.pdf

6

http://www.foreignword.com/Technology/mt/mt.htm

2.2 MT System Architectures and Strategies
In this section, MT strategies will be explained. MT has three main approaches:
Direct Translation, Rule Based Translation, and Corpus Based Translation. In addition,
Corpus Based Translation has two strategies: Statistical and EBMT [7]. Figure 2.1
shows the strategies used in MT:
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Machine Translation

Direct

Corpus Based Translation
Rule Based Translation

Translation
Statistical Translation

EBMT

Hybrid Translation

Figure 2.1. Machine Translation Strategies

2.2.1 Direct Translation
A direct translation system is designed for a particular source and target
language. This system does not need to analyze the sentence structurally or
morphologically. The system translates word-by-word so the translation system uses
large dictionaries. Some simple grammatical adjustments e.g. on word order and
morphology are later performed on the words translated. Systran is basically a direct
translation system.
2.2.2 Rule-Based Translation
This approach requires the analysis and representation of the 'meaning' of source
language and the generation of the equivalent target language. Rule-Based MT has two
major approaches: The first one transfer and approach operates in three stages - analysis
into source language, transfer to target language, and generation or synthesis of the
target language.
The second approach is the Interlingua (IL) which has three steps. The first step
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translates source texts into abstract language independent description; the second step
translates this description into equivalent target language; and finally generates the target
language text. The IL system supposes that it is possible to translate source texts to more
than one language with abstract representation. Translation is thus in two stages: from
the source language to the IL and from the IL to the target language. Esperanto language
is used in some interlingua systems [12].
In addition, another IL language example used is Eurolang which is used in the
translation between ten language pairs such as English-French-German, Italian and
Spanish, and French-German[12].
2.2.3 Corpus-Based MT
This method supposes that the reference translations from source language to
target language have equivalent meanings. These systems presume with given sample
texts, one can achieve suitable source language/target language linking mechanism. This
system can only be generated if suitable example translation set is available in the
sample text. Corpus Based system includes two methodologies: statistical and example
based MT.
Corpus-Based approaches are differentiated with direct use of information. This
information is derived from corpora for the analysis, transfer and generation of
translations and indirect use of corpora that is used as source of information for deriving
or compiling lexical, grammatical and knowledge databases, and as sources of statistical
information about source and target languages.
Examples of methodologies that employ direct use of information are statisticsbased, example-based and connectionist approaches. Lexical and knowledge acquisition
and the use of statistical information in other rule-based systems are examples of indirect
use of corpora.

6

2.2.4 Statistics-Based MT
The basis of the method is to use of the probabilities that any one word in a
sentence of one language corresponds to two, one or zero words in the translated
sentence in the other language. The IBM research on this type is based on a large corpus
of the Canadian Hansard, which records parliamentary debates in both English and
French[12].
2.2.5 Example-Based MT
The basic argument for Example Based MT (EBMT) is that, translation involves
finding or recalling analogous examples, discovering or remembering how a particular
source language expression or something similar has been translated before. A more
detailed analysis of EBMT can be found in the next section.
2.2.6 Hybrid Methods
Hybrid methods merge the rule-based approaches and the corpus-based
methods.
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CHAPTER III

EXAMPLE BASED MACHINE TRANSLATION

EBMT is an acronym for Example-Based Machine Translation. EBMT is based on
the use of translation of a sentence that has been previously translated in the corpora.
Turkish sentence is in the form of SOV (Subject, Object, Verb) like Japanese grammar
structure. EBMT has used by Japans scientist successfully. So EBMT is selected this
work.
EBMT must use a bilingual corpus which consists of the source and target
languages and samples dependent on the domain. EBMT consists of three phases:
matching, alignment, and recombination [10]. EBMT starts with matching using a
matching algorithm that finds the examples that are most similar as a whole or part to
the input sentence. Then the alignment step rebuilds the input sentence using a
combination algorithm through the combination of found is performed. Lastly,
recombination transfer and composition algorithm extracts corresponding target parts
and combines them into a sentence in the target language.
Figure 3.1 shows EMBT architecture. As shown in the figure, a sentence is taken
from source language and is searched in the BKB (Bilingual Knowledge Bank) for a
sentence or part of sentence that is similar. If a similar sentence is found, corresponding
part of the sentence is taken from the target text in the BKB. Lastly, the recombination
procedure is performed to achieve the translation into the target sentence.
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Source

Target

Retrieve

Find closest

Corrsponding

related Source

Combination

correspondence

For Source

For Target

language

language

BKB

Figure 3.1 EBMT architecture
3.1 History of EBMT
EBMT has been initially mentioned in the paper by Makoto Nagao in 1981 and in
a conference in 1984 [12]. EBMT is called “machine translation by example-guided
inference or machine translation by the analogy principle as described by Nagao [12].
“Man does not translate a simple sentence by doing deep linguistic analysis, rather,
man does translation, first, by properly decomposing an input sentence into certain
fragmental phrases .., then by translating these phrases into other language phrases, and
finally by properly composing these fragmental translations into one long sentence. The
translation of each fragmental phrase will be done by the analogy translation principle
with proper examples as it references“ [12].
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3.2 EBMT Methodology
EBMT has three main parts: matching phase to find a suitable example from
database of real examples of source language, a translation phase, and then recombining
these to give the target text. This is explained by a pyramid diagram as seen in Figure
3.2, which is first used by Vauquois in 1968 (pyramid has been adapted for EBMT [12]).
In conventional MT make analysis whereas in EBMT perform matching. The input is
the same example or examples set. First phase is matching where the suitable example or
examples have been selected. The matching process is controlled by the semantic
similarity between the lexical items in the input text and the corresponding items in the
database.
In the next phase, if the system finds a suitable example, it selects corresponding
parts in the target text. This phase is named alignment or adaptation and it is the same as
the transfer method in conventional MT. If suitable parts have been selected, they must
be combined in a way to achieve a target text, which is like the generation phase of
conventional MT.

Figure 3.2. The “Vauquois pyramid” adapted for EBMT
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EBMT has a lot of different extensions such as Memory-Based Translation
(MBT), Transfer-Driven Machine Translation (TDMT) and Case-Based Machine
Translation (CBMT).
1) She likes chocolate.
Matches
2)

a) She likes ice cream.
O dondurma sever.
b) I eat chocolate.
Ben çikolata yerim.

Result
3)

She likes chocolate.
O çikolata sever
Figure 3.3 Example of EBMT

The example above Figure 3.3 shows that resulting in the translation of (1) can be
a combination of the appropriate parts from (2a,b) so the system takes (3). First of all the
system must take suitable parts of the example sentence.
3.2.1 Parallel Corpora
EBMT uses parallel corpora to compare source language and target language text.
The following are examples of some parallel corpora; “The Canadian and Hong Kong
parliaments have bilingual corpora in the form of their parliamentary proceedings, the
European Union has multilingual documents and World Wide Web pages are available
in two or more languages”. After suitable corpus is built, the problem of alignment must
be solved, i.e. identifying which parts (typically sentences) corresponds to each other
[12].
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3.2.2 Granularity of Examples
Length and similarity problems appear in the first step of EBMT matching step.
These problems are: the longer the matched texts, the lower the probability of a
complete match or the shorter the texts, the greater the probability of ambiguity and the
greater the danger that the resulting translation will be of low quality, due to text
boundary friction and incorrect chunking [12].
3.2.3 Number of Examples
There are reported issues to be addressed when parallel corpora is established such
as the number of examples. One experiment, constructed by Mima et al. (1998) [12]
showed how the quality of translation improved as more examples were added to the
database. To test cases of the Japanese adnominal particle construction, they loaded the
database with 774 examples in increments of 100. Translation accuracy increased
steadily from about 30% with 100 examples to about 65% with the complete set. A
similar result was found with another trial, rising from about 75% with 100 examples to
nearly 100% with all 689 examples. Sumita & Lida (1991) [51] and Sato (1993) [52]
also suggest that adding examples improves performance. This experiment reported that
the improvement was more or less linear; it showed that there is some limit after which
further examples cannot better the quality. After some limit, if the size of examples are
increased the performance starts to decrease.
3.2.4 Suitability of Examples
A lot of EBMT systems work from a manually constructed database of examples,
or from a carefully filtered set of “real” examples. Because, a huge corpus of naturally
occurring text will contain overlapping examples of two sorts: some examples will
reinforce each other by shows the identical translation phenomenon, however other
examples will be in conflict. Like Somers et al., 1994 [31]; Öz & Cicekli, 1998[38];
Murata et al., 1999 [53] have mentioned, systems comprise a similarity metric which is
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sensitive to frequency, so that a large number of similar examples will increase the score
given to certain matches.
3.2.5 Storage of Examples
EBMT systems have different storage types. Clearly, the storage types are related
to the problem of searching for matches. One of these storage types is where the
examples are stored as pairs of strings with no additional information. If example
database is very large, indexing techniques are required, so Information Retrieval (IR)
must be used.
3.2.5.1 Annotated Tree Structures
First storage method, which stores the examples as fully, annotated tree structures
with explanation and links. Figure 3.4 shows how the Japanese sentence (3.1) “She has
long hair” and its English translation are represented [14].
3.1) Kanojo wa kami ga nagai.
she topic hair subj is-long
‘She has long hair.’

Figure 3.4. Representation scheme for (3.1)
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More recently, a similar approach has been used by Poutsma (1998) and Way
(1999): there, the source text is parsed using Bod’s (1992) DOP (data-oriented parsing)
technique, which is itself a form of example-based approach, then matching subtrees are
combined in a compositional manner. In the system of Al-Adhaileh & Kong (1999) [15],
examples are stored in dependency structures with links at the structural and lexical level
expressed by indexes. Figure 3.5 shows the representation for the English–Malay pair in
(3.2).
3.2

a. He picks the ball up.
b. Dia kutip bola itu

Figure 3.5. Representation scheme for (3.2)

The nodes in the trees are indexed to represent the lexical head and the span of the
tree of which that item is the head: So for example the node labeled “ball(1)[n](3-4/2-4)”
indicates that the subtree is headed by ball, which is the word spanning nodes 3 to 4 (i.e.
the fourth word) when is the head of the subtree spanning nodes 2 to 4, i.e. the ball. The
box labeled “Translation units” gives the links between the two trees, divided into
“Stree” links, which identifies subtree correspondences (e.g. the English subtree 2-4 the
ball corresponds to the Malay subtree 2-4 bola itu) and “Snode” links, which identifies
14

lexical correspondences (e.g. English word 3-4 ball corresponds to Malay word 2-3
bola).
3.2.5.2 Generalized Examples
Some systems combined similar examples and store them as a single “generalized”
example. Brown [16] tokenizes the examples to show equivalence classes such as
“person’s name”, “date”, “city name”, and also linguistic information such as gender and
number. In this method, sentence’s part in the examples is changed by these tokens, so
the examples are more general. For example, (3.3 a) can be generalized as (3.3 b), and
even, further as (3.3 c). If the system has an input like (3.3 d), this can be matched quite
easily with (3.3. c) which can then be used as a template, whereas a match with the
original text (3.3a) would be more difficult because of the differences.
3.2) a. John Miller flew to Frankfurt on December 3rd.
b. <1stname><lastname>flew to<city>on<month> <ord>.
c. <person-m> flew to <city> on <date>.
d. Dr Howard Johnson flew to Ithaca on 7 April 1997.
3.2.5.3 Statistical Approaches
For this storage technique, the basic structure which occurs more statistically in a
language is stored in the database, so that the probability of translating a source text
structure into a target text structure can be computed.
3.3 Matching
EBMT system starts to translate by finding the suitable example in the source
language database. This search problem depends on how the examples are stored. For
example; in the statistical method, the problem is essentially mathematical: maximizing
a huge number of statistical probabilities.
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3.3.1 Character-Based Matching
Matching techniques are needed in distance or similarity calculation. Firstly, the
measure may be character-based pattern-matching in the examples that are stored as
strings. In the earliest MT systems, only exact matches were possible [17], for example
(3.4 a) would be matched with (3.4 b), but the match in (3.5) would not be found
because the system has no way of knowing that small and large are similar.
3.4)

a. This is shown as A in the diagram.
b. This is shown as B in the diagram.

3.5)

a. The large paper tray holds up to 400 sheets of A3 paper.
b. The small paper tray holds up to 300 sheets of A4 paper.

3.3.2 Word-Based Matching
This measure was suggested by Nagao [18] and was used in some EBMT systems.
This measure is based on similarity of meaning or usage. In the example, this measure
can match if words in the input string are replaced by near synonyms. Nagao’s measure
is particularly effective in choosing between competing examples, as in Nagao’s
examples, where, given 3.6 a,b as models, the system choose the correct translation of
“eat” in 3.7 as a taberu “eat (food)”, in 3.6 b as okasu “erode”, based on the relative
distance from he to man and acid, and from potatoes to vegetables and metal.
3.6) a. A man eats vegetables. Hito wa yasai o taberu.
b. Acid eats metal. San wa kinzoku o okasu.
3.7) a. He eats potatoes. Kare wa jagaimo o taberu.
b. Sulphuric acid eats iron. Ryūsan wa tetsu o okasu.
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3.3.3 Carroll’s “Angle of Similarity”
This measure suggested by Carroll [19] is a trigonometric similarity measure
based on both the relative length and relative contents of the strings to be matched. This
measure searches for similar words and takes account of deletions, insertions and
substitutions in the database for a given example. It evaluates a cost and the cost can be
programmed to build linguistic generalizations.
3.3.4 Structure-Based Matching
This method requires examples that are stored as structured objects like a tree, and
it involves tree-matching [20]-[23].

The “tree edit distance” can be used for tree

comparison. Utsuro [24] attempted to reduce the computational cost of matching by
taking the advantage of surface structure of Japanese language, in particular its caseframe-like structure. They developed a similarity measure based on the head nouns.
Their method relies on the verbs matching exactly, and is limited to Japanese or
similarly structured languages.
3.3.5 Partial Matching For Coverage
In the techniques mentioned above, it has been assumed that the aim of the
matching process is to find a single example or a set of individual examples that
provides the best match for the input. Another method is found in Nirenburg et al [25].
The matching function decomposes the cases, and makes a collection of respective
terminology – “substrings”, “fragments” or “chunks” of matched material.
3.4 Alignment (Adaptability) and Recombination
After matching, the system must translate the separated fragments (alignment or
adaptation), and combine these parts to build a grammatical target output
(recombination). This step has two problems: one of them is decide which part of the
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associated translation corresponds to the matched parts of the source text, and the other
is recombining these parts in a suitable manner.
If the examples are stored as tree structures with the explicit correspondences
between the parts, the alignment problem automatically disappears. For example, in Sato
[26], the recombination stage is a kind of tree unification, Watanabe [27] on the other
hand, adapts a process called “gluing” from Graph Grammars, which is a form of graph
unification. Al-Adhaileh & Tang [15] state that the process is “analogous to top-down
parsing”.
Even if the examples are not annotated with the relevant information, in many
systems the underlying linguistic knowledge includes information about correspondence
at word or chunk level. This may be because the system makes use of a bilingual
dictionary [29] or existing MT lexicon, as in the cases where EBMT has been
incorporated into an existing rule-based architecture, e.g. Sumita [30]. Alternatively,
some systems extract automatically from the example corpus information about probable
word alignments, [31]-[34].
3.4.1 Boundary Friction
Boundary friction is a problem that some languages like Japanese and English
have little or no grammatical inflection to indicate syntactic function [34]. For example,
the translation associated with “the handsome boy” retrieved, from 3.8 is equally
reusable in either of the sentences in 3.9. This however is not the case for a language like
German (and like Turkish), where the structure of the determiner, adjective and noun
can all carry inflections to indicate grammatical case, as in the translations of 3.9 a,b,
shown in 3.10.
3.8

The handsome boy entered the room.

3.9

a. The handsome boy ate his breakfast.
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b. I saw the handsome boy.
3.10 a. Der schöne Junge ass seinen Frühstück.
b. Ich sah den schönen Jungen.
A hybrid system can solve this problem. This system has a grammar of the target
language, so it can take the results of the gluing process and somehow smooth them
over.
3.4.2 Adaptability
Can all examples be equally reusable with their notion of “adaptability”? This
question is asked by Collins & Cunningham [35]. Their example-retrieval method
includes a measure of adaptability which shows that the similarity of the example has
internal structure and external context. The notion of “adaptation-guided retrieval” has
been developed in Case-Based Reasoning (CBR) [36]. In this notation, cases are
retrieved from the example-base. It is not only their similarity with the given example,
but also the extent to which they show a good model for the desired output. i.e. to which
they can be adapted, that determines whether they are chosen. EBMT system, ReVerb,
stores the examples together with a functional annotation, cross-linked to indicate both
lexical and functional equivalence. Therefore, example-retrieval has two steps: the
closeness of the match between the input text and the example, and the adaptability of
the example, on the basis of the relationship between the example and its translation.
3.4.3 Statistical Modeling
Another approach to recombination is the statistical system where recombination
is depicted as a statistical modeling problem. There is the “language model” that is
invoked, with which the system tries to maximize the product of the word-sequence
probabilities. This approach suggests that “recombined” target-language proposals could
be verified: the frequency of co-occurrence of sequences of 2, 3 or more words (n-
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grams) can be extracted from database. If the target-language corpus is bigger, then
appropriate statistics about the probable “correctness” of the proposed translation could
be achieved. There are well-known techniques for calculating the probability of n-gram
sequences, and a similar idea is found in Grefenstette’s [37] experiment, mentioned
above, in which alternative translations of ambiguous noun compounds are verified by
using them as search terms on the World Wide Web.
3.5 Computational Problems
Above mentioned methods have to be implemented as computer programs, and
significant computational factors influence many of them. One criticism to be made of
the methods which store the examples as complex annotated structures is storage and
matching/retrieval algorithms. This is especially problematic if such resources are
difficult to obtain for one (or both) of the languages, as Güvenir & Cicekli [38] report,
relating to earlier work by Güvenir & Tunç [39] on Turkish.
Other criticism is that the complexities involved decrease from some of the alleged
advantages of EBMT, especially the idea that the system’s linguistic knowledge can be
extended “simply” by increasing the size of the example-set [40]: adding more examples
becomes a significant overhead and then these examples must be parsed, and the results
should be possibly checked by a human. Another advantage of the EBMT method is that
system can be developed despite the lack of resources such as parsers, lexicons and so
on.
One important computational issue is speed, particularly for real-time speech
translation [41]. Massively Parallel Processors was used a small example base (1,000
cases) and achieved processing speeds almost 13 times faster than a more conventional
architecture. For a more significant database, say 64,000 examples, the improvement
would be 832 times. They warn however that speed advantages can be lost if the
communication between the parallel processors and other processors is inefficient.
Researchers want to find ways of maximizing the effect of the examples by identifying
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and making explicit significant generalizations. Hybrid systems solve the problem by
combining the advantages of both the example-based and rule-based approaches.

21

CHAPTER IV

EXAMPLE-BASED MACHINE TRANSLATION BASED ON THE
SYNCHRONOUS SSTC

In this chapter, a method for EBMT will be explained. This method creates a link
between the string in a language and its representation tree structure which can be
interpreted for both analysis and generation in MT. In Figure 4.1 a flexible annotation
structure called Structured String-Tree Correspondence (SSTC) is given which was
declared in Boitet & Zaharin [42] to record the string of terms, its combined
representation structure and the corresponding sentence, which is stressed by the subsentence corresponding part of a SSTC.
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Figure 4.1 The correspondence between the string “he picks the box up” and its
representation tree
Figure 4.1 is showed that the correspondence between the string “he picks the box
up” and its representation tree (dependency tree and phrase structure tree), together with
the sub-correspondences between the substrings and subtrees
As mentioned above the SSTC is a general structure that can combine a tree
structure to string in a language which is the interpretation structure of the string, and
more importantly is the facility to specify the correspondence between the string and the
associated tree which can be nonprojective [42]. These features are very important in the
design of an annotation scheme, in particular for the treatment of linguistic phenomena
e.g. crossed dependencies [43]
SSTC can be summarized as a triple (st, tr, co), where st is a sentence or part of
the sentence in source or target language, tr is its combined representation tree structure
and co is the correspondence between st and tr. co between a string and its
representation tree is made of two type correspondences between nodes in a tree and
substrings in a string or between subtrees and substrings. The correspondence (co) is
shown in each node N in the representation tree as two sequences of INTERVALS
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called SNODE(N) and STREE(N). SNODE(N) is an interval of the sub sentence in the
sentence that corresponds to the node N in the tree. STREE(N) is an interval of the sub
sentence in the sentence that corresponds to the subtree having the node N as root [44].
The notation used in SSTC demonstrates a correspondence consisting of a pair of
intervals X/Y linked to each node in the tree, where X(SNODE) demonstrates the
interval containing the substring that corresponds to the node, and Y(STREE)
demonstrates the interval containing the substring that corresponds to the subtree having
the node as root. This statement shows which word/s of the text corresponds/s to which
node in the tree. For describing a NL using SSTC, a set of constraints were defined to
govern such correspondences [28].
X:SNODE and Y:STREE intervals are governed by the following constraints:
i) Global correspondence: an entire tree corresponds to an entire sentence.
ii) Inclusion: a subtree which is part of another subtree T, must correspond to a substring
in the substring corresponding to T.
iii) Membership: a node in a subtree T, must correspond to a word which is member of
the substring corresponding to T [44].
Figure 4.2 shows the sentence “The young girl looked” with its corresponding
SSTC. It is a simple projective correspondence. An interval is assigned to each word in
the sentence, i.e. (0-1) for “The”, (1-2) for “young”, (2-3) for “girl” and, (3-4) for
“looked”
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Figure 4.2 Representing a “The young girl looked” sentence and SSTC tree
A substring in the sentence which corresponds to a node in the representation tree
is indicated by assigning the interval of the substring to SNODE of the node, e.g. the
node “girl” with SNODE interval (1-2) corresponds to the word “girl” in the string with
the like interval. The correspondence between subtrees and substrings are indicated by
the interval assigned to the STREE of each node, e.g. the subtree rooted at node “eat”
with STREE interval (0-4) corresponds to the whole sentence “the young girl looked”.
4.1 Constructing a Bilingual Knowledge Bank Based on the Synchronous SSTC
Bilingual Knowledge Bank (BKB) containing bilingual parallel texts which links
between the source and the target sentences is popular in implementing such EBMT
systems. Sentences in the BKB are explained with their constituency or dependency
structures, which supply the correspondences assembled at the structural level. The
system chooses the dependency structure as the linguistic representation of the SSTC as
it gives a natural way to set up the translation units between the source (English) and
target (Turkish) SSTCs. In addition, it is believed that in order to increase the
performance of the MT system, the SSTC structure can be extended to keep multiple
levels of linguistic information. With this approach, translation examples are established
by means of a synchronous SSTC editor as illustrated in Figure 4.3 [15].
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English

Turkish

Figure 4.3 Represent “The young girl looked” and its SSTC and Turkish translation
sentence “Genç kız baktı” and SSTC
The translation units are indicated in terms of STREE pairs (for phrases) and
SNODE pairs between the source (English) and the target (Turkish) SSTCs. For
example, as shown by the synchronous SSTC given in Figure 4.3, the fact that "looked"
is translated to "baktı" is expressed by (3-4, 0-4) under the index SNODE of the
translation units. Whereas, the fact that "the young girl" is translated to "genç kız" is
expressed by (0-3, 0-3) under the index STREE of the translation units. In Figure 4.4,
index of the SNODE and STREE can be clearly understood.
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English

Turkish

Index
Index Stree
(0-4,0-4)
(0-1,0-1)
(1-2,1-2)
IndexSnode
(3-4,3-4)
(2-3,2-3)
(0-1,0-1)

Figure 4.4 Index of English and Turkish Sentence

The main characteristic of SSTC is flexibility. That flexibility is required in
establishing translation units between source and target substrings which can be possibly
discontinuous in both cases.
4.2 Example-Based Machine Translation Based On the SSTC
Figure 4.5 shows the process of translation of a source sentence into a target
sentence [15]. The tagged source sentence must be parsed to establish a single rooted
representation tree, based on the example-based parser. The parser builds the sub-SSTCs
for all phrases in the source sentence by referring to some closely related examples in
the BKB. To each sub-SSTC built for the source sentence, the corresponding target
sentence sub-SSTC can be designated based on the translation units as established by the
synchronous SSTCs in the BKB.
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Figure 4.5 Example-Based Machine Translation Based on the Synchronous SSTC
The source and target sub-SSTCs constituted together with the corresponding
translation units identified will be formed as a list of sub-synchronous SSTCs. A list of
sub synchronous SSTCs is constructed from the selected example, which will be
replaced by their corresponding sub-synchronous SSTCs constituted from the source
sentence to form the final synchronous SSTC through a combination process. Lastly, the
target sentence as shown in the target SSTC will be obtained as an output as the
translation of the source sentence. In the following part, an example to illustrate the
process of translation will be presented as described above. Suppose the system intends
to find the translation for the English source sentence “the young girl bought a green
dress”, based on the set of examples represented in the example-base (BKB) in Figure
4.6.
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First of all the system finds examples in the BKB which includes a word in the
source sentence appearing as the root word of the dependency tree in its source SSTC. If
more than one example are found (in most cases), the system must calculate the distance
between the source sentence and these examples. The closest example (namely the one
with minimum distance) will be chosen as a reference to combine the list of generated
sub-synchronous SSTCs to form a complete synchronous SSTC [15].
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Figure 4.6 A set of synchronous SSTCs containing the English sentences, the Turkish translation sentences and their translation units
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Figure 4.7: The replacement on the synchronous SSTC example and the translation for the source sentence “the young girl
bought a blue dress".
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The sub-synchronous SSTCs computed from example (E, T) will be replaced by
the corresponding sub-synchronous SSTCs built from the source sentence to form a
complete synchronous SSTC. This approach is like the top down parsing technique.
Consequently, the target sentence revealed in the target SSTC has been produced as the
translation of the source sentence, i.e. “The young girl bought a blue dress” as illustrated
in Figure 4.7
In the next step, the system must re-organize the target SSTC, since the English
sentence structure is different than the Turkish sentence structure. Basically, simple
English sentence grammar is SVO (Subject, Object, Verb), however, Turkish sentence is
in the form of SOV (Subject, Object, Verb). If the system does not align, the translation
sentence, “Genç kız aldı bir mavi elbise” will be produced. After the alignment process,
based on the simple Turkish grammar rule, the system can produce “Genç kız bir mavi
elbise aldı”. Figure 4.8 shows the re-organized target SSTC result.

Figure 4.8 Alignment of SSTC
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CHAPTER V

ORHUN: AN EXAMPLE-BASED MACHINE TRANSLATION SYSTEM
BASED ON THE SYNCHRONOUS SSTC

In this chapter, the design of the ORHUN system will be described. In this
system, translation from English to Turkish is performed using synchronous SSTC
annotation schema as in the EBMT. The system has been named as ORHUN which is
the first written monument in Turkish. The design of the ORHUN system is shown in
Figure 5.1.

O RHUN
E ng lis h
s en ten ce
T u rk is h
s en ten ce

PA R SI N G
Se n t en c e in T re e

T R A N SL A TI O N

M AT C H IN G

F o r E n g lis h

co rr e s p o nd en ce

la ng ua g e

AL IG N MEN T

F or T urk i sh t
l an gua ge

BK B
O G UZ

Figure 5.1 Design of the ORHUN system
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The system has three main components which are parsing, matching and
translation/alignment. Firstly, the parsing component parses a given sentence and
forms a parameter in the form of a tree which includes the information about the
given sentence. In the matching module, the separate subtrees are formed from the
tree parameter, and these subtrees are compared against the subtrees of the other
English sentence trees retrieved from the database. These subtrees are compared by
using the top down search method. If the system finds equal subtrees, the Turkish
subtree which corresponds to the matched English subtree is retrieved. All of the
subtree matching process finishes but some subtrees have not been translated then the
system retrieves another English sentence tree from the database. The system requires
the usage of large corpora; consequently the storage mechanism becomes especially
important for the system. Before giving the sample run for the components of the
system, example sets of storage will be describe in the following section.

5.1 System Domain
As the domain of the MT system, MS Office Help documents have been selected.
As EBMT system requires parallel corpora, MS Office Help documents, which includes
one English sentence corresponds to one Turkish sentence, proves a suitable domain.
However for the system to operate, both English and Turkish parsers were required. Yet,
the number of parsers developed for the Turkish language that were available to be used
by other systems was minimal. There are a lot of works about Turkish NLP at Boğaziçi
University [45], Bilkent University [46], METU [47], and Istanbul Teknik University
[48], and Turkish parsers have been developed, however, either there was no access to
them, or they did not produce high-quality results for this working. Finding the word
types and grammatical structure of a Turkish sentence to create the Turkish tree structure
created a major problem with these parsers. For example, Zemberek [49], and the parser
developed by Bogaziçi University [45] and METU [47] were tried, but access was not
allowed.
As mentioned before, MS Office help documents were used as the parallel
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corpora. Figure 5.2 shows some English sentences and their corresponding Turkish
translations found in the help documents. As seen in the examples in Figure 5.2, there
are a lot of similar sentences in the help documents.
In the Style type box, click Character. Stil türü kutusunda Karakter'i tıklatın.
In the Style type box, click List.

Stil türü kutusunda Liste'yi tıklatın.

In the Style type box,click Paragraph. Stil türü kutusunda Paragraf'ı tıklatın.
In the Style type box, click Table.

Stil türü kutusunda Tablo'yu tıklatın.

Figure 5.2 Examples of MS Office help document sentences
5.1.1 Storage of Examples
The system uses SSTC annotation schema for the storage of the sentences,
therefore a table structure is required which can include a tree structure. For parsing an
input sentence, the Stanford Parser [50] is used and the resulting tree is stored in the
table. The details about the Stanford Parser [50] are given in the next section.
5.2 System Components
ORHUN has three main components. Parsing is the first step where a source
sentence is parsed and outputted as a tree. The next step is matching where the tree that
includes the information about the source sentence is compared against the corpus
sentences to try to find a similar sentence in the database. If a similar sentence is found,
the corresponding Turkish sentence is taken from the database. In order to perform these
steps, system must parse the source sentence correctly.
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Figure 5.3 Design of the ORHUN system components

5.2.1 Parsing Component
A natural language parser is an application that analyzes the grammatical structure
of sentences. For example; given a sentence, the parser decides on the categories (e.g.
noun, verb, adjective, etc.) of all the words, and the roles (e.g. subject, object, etc.) they
play in the sentence. There has been more academic research about parsing in the
English language than in any other language. In comparison, the research on developing
a parser for the Turkish language is one of the most important problems in MT research
dealing with the Turkish language.
Probabilistic parsers use knowledge of language gained from hand-parsed
sentences to try to produce the most likely analysis of new sentences. This approach may
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result some mistakes, but in general gets close to the correct result. For parsing the
English sentences, Stanford Lexicalized Parser package is used [50]. The Stanford
Lexicalized Parser [50] is a statistical NLP parser developed at Stanford University. The
corpus that is used by the Stanford Parser is like a corpus that used the Penn Treebank
style used bye The University of Pennsylvania [50]. It uses probabilistic context free
grammar (PCFG) parser which outperforms standard lexicalized models used for
English. These grammar rules are implemented in a file named englishPCFG.txt.
The Stanford Lexicalized Parser package is a Java implementation of probabilistic
natural language parsers. The parser supports highly optimized PCFG and dependency
parsers, and a lexicalized PCFG parser. The lexicalized probabilistic parser implements
a factored product model which uses the A* algorithm.
The version of the parser which was used by ORHUN requires at least JDK 1.4.
The parser also requires plenty of memory (a minimum of 100Mb to run as a PCFG
parser on sentences up to 40 words in length; typically around 500Mb of memory to be
able to parse similarly long typical-of-newswire sentences using the factored model).

Figure 5.4 Parsing Component Structure
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Figure 5.4 shows the Parsing Component Structure. First of all, the system selects
a PCFG file for English language and writes a sentence for parsing and then the parser
provides grammatical relations output as well as phrase structure trees for this sentence.
In Figure 5.5, the parse of the sentence “She bought a blue dress” by the Stanford Parser
is shown.

Figure 5.5 Example of a tree built by Stanford Parser
ORHUN implements the SSTC method to translate a given sentence, which
requires a tree structure as the storage mechanism. To implement this method, a tree is
generated by the Stanford Lexicalized Parser which is stored in the tree database. Figure
5.6 shows the main tables in the database. In EnglishSentence table, SentenceId is a
unique number for a sentence. LexId is an id to show the part of the sentence. LexType is
a string that shows type of word. ParentLexId is an id that shows parent’s Id and Word
shows a word. If Word is not null this shows that it is a leaf in the tree.
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Figure 5.6 Table structure of the Database
In Figure 5.7, the storage of the example sentence “She bought a blue dress” in the
EnglishSentence table is shown.

Figure 5.7 Example of “She bought a blue dress” in the EnglishSentence
5.2.2 Matching Component
This step is the most important step for the translation systems that use EBMT.
Firstly, the system takes a tree of an input sentence from the parser. This tree, called as
“source tree” (ST), is separated to subtrees by the system. Since one sentence can simply
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include subject, object and verb; the system has to search component by component.
Like ST, the system takes a tree from the database called as “database tree” (DT). the
system must separate the DT to subtrees for comparison to ST’s subtrees. Figure 5.8
shows the matching component structure.

Figure 5.8 Matching Component
After the separation process, the system takes one tree referred as st1 which is a
subtree of ST and compares it to a tree dt1 that is a subtree of DT. The system compares
st1 and dt1 node by node. If the two trees have equal nodes, this shows that these
subtrees (part of sentence) have the same grammatical structure. If two trees do not have
equal nodes, the system takes a new subtree from the DT.
If the system finds that st1 and dt1 are equal, the system looks at their leaves that
include words in the sentence. Thus, the system finds a word in the database that has the
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same grammatical task as the ST word. If the system finds all of leaves in the st1 equal
to dt1 this shows us that the system can translates st1 to Turkish. The system takes a
Turkish sentence or part of a sentence from the database that corresponds to dt1 and the
system adds a character (**) in the subtree root which shows us that this sentence is
translated.
Next, the system takes another subtree from the ST and tries to find an equal
subtree in the DT. If ST is finished and the system has a subtree that does not find equal
subtrees in the DT yet, the system takes another DT in the database. Consequently, the
system looks for all database sentences. If the system finds equal subtrees for the
combination ST translation ends in success.
5.2.3 Alignment Component
The Turkish grammatical structure is different from the English grammatical
structure. For example, English sentence structure is SVO (Subject, Verb, Object).
However Turkish sentence structure is SOV (Subject, Object, Verb). This is a problem
for translating English to Turkish. Figure 5.9 explains this problem.

Figure 5.9 An example of result of matching
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For the ORHUN system, MS Office Help Document, in which sentences nearly
have the same grammatical structures, is used. Only the sentences that are built up with
Simple Present Tense are used in corpus. Hereby, the domain is limited out to simple
sentences by using present tense. With a good Turkish parser, however, this problem can
be solved, which will then increase the variety of the sentences that can be translated.

Figure 5.10 Alignment Component
Figure 5.10 shows the alignment component. ORHUN uses basic alignment rules.
For example, in Turkish, Object comes before the Verb, whereas in English, the Verb
comes before the Object. Thus, the corresponding tree nodes for Verb and Object need
to be interchanged. In the future, these rules will be extended.
5.3 Implementation of ORHUN
The system is developed with the Java programming language (JDK 1.5) using
Borland Jbuilder 2006 integrated development environment. The English and Turkish
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example sentence sets have been stored in a sample database developed in Ms Access
which has been named as OGUZ.
ORHUN uses Stanford Parser for parsing the English sentence, so the system uses
Stanford Parser tree structure. First of all, it is better to explain this tree structure.
5.3.1 Class Tree
ORHUN is based on a tree structure. The system implemented all tree applications
in a tree class. For example, a tree is created and a child is added or trees are compared
whether they are equal. Stanford Parser uses A(*) algorithm and the system use top
down search method for searching in the tree. Appendix B shows some methods of Class
Tree.
5.3.2 Class SentenceDataAccess
This class includes the methods for all of the database actions. First of all
connect() method makes a connection by OGUZ database, and this class uses
SentenceEntry class that denotes sentence structure. Some of the methods in this class
will be explained shortly.
public SentenceEntry findSentence(int sentenceId,int lexId): takes two integers as
parameters, finds a part of a sentence from the EnglishSentence table from the database
with a given sentenceId and lexId. This function returns a SentenceEntry.
public SentenceEntry findTurkishSentence(int sentenceId,int lexId): this method is
similar to findSentence but this method takes data from the TurkishSentence table in the
database.
public int getMaxSentId(): gives maximum sentenceId from the EnglishSentence table.
public boolean newSentence(SentenceEntry sentence): inserts an English sentence to the
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EnglishSentence table in the database. Before the insert, it calculates (maximum
SentenceId + 1) for primary key of EnglishSentence table.
public boolean saveSentence(SentenceEntry sentence): takes type of SentenceEntry as a
parameter and then it updates EnglishSentence.
public boolean deleteSentence(SentenceEntry sentence): deletes an English sentence
from the EnglishSentence table in the database.
public ArrayList getSentenceIdArrayList(): gives a list that includes all SentenceIds. The
system may search all sentences during a matching process. In matching phase the
system takes a sentence and compares it to source sentence and then if system does not
match, the system must retrieve a new sentence from the database. So the system uses
getSentenceIdArrayList to take all sentenceIds from the EnglishSentence table.
public Tree getSentenceTree(int sentenceId): takes an integer as a parameter and takes a
sentence from EnglishSentence table given by sentence’s id and returns it.
public Tree getTurkishSentenceTree(int sentenceId): like getSentenceTree method, it
takes an integer as a sentenceId and takes a sentence from the TurkishSentence as a tree
and returns it.
public void close(): the connection to the Oguz database before the system is closed.
5.3.3 Class EBMT Frame
This class deals the screen item positions and controls workflow. This class uses
EnglishPanel and TurPanel classes.
public static void main(String args[]): Our program starts with this method. This method
calls EBMTFrame that includes menu for some operations as well as the EngPanel and
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TurPanel. These panels will be explained below. The components of menu will be
explained shortly.
private void jbInit(): this method includes screen item property and its given initial
knowledge of fields that includes menu and panels.
Parser (Load File, Load Parser, Exit)
English (Save Database, Get EnglishSentenceTree from DB)
Turkish(Save Database)
EBMT(searchDatabase)
private void exitForm: closes the program.
5.3.3.1 Class EngPanel
This class has a panel which includes the English sentence. User enters an English
sentence which is initially parsed by the system and at the bottom half of the screen the
tree that shows the sentence structure is outputted. Other important methods in the
EngPanel are described below;
public void loadFile(): User can write one sentence or select a file that includes several
sentences to be parsed.
public void loadParser() : The system must use a PCFG file for parsing. User can
choose one of the englishPCFG.txt or englishPCFG.ser.gz files. Stanford Parser uses
these files for parsing.
public void parse(): This method parses the sentence and shows the sentence on the
screen as a tree.
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5.3.3.2 Class TurPanel
During the matching phase, if the system finds one (or a lot of) sentence in the
database that matches to the source sentence or part of source sentence, the system
shows this sentence or sentences and matching part in the TurPanel. If the system can
make a translation from source sentence to Turkish sentence, it shows translation
sentence in the TurPanel again.
5.3.4 Class EBMT
This class performs all of the translation actions. The method details are explained
below:
public static Collection subTrees (Tree t, Collection n): the system makes a search in the
tree during the matching phase. It uses top down search. Since the system can find the
same part of source sentence in any part of database sentence it sometimes searches all
tree, or sometimes it searches only one part of the tree. The system takes all subtrees of
given tree in a collection and returns it.
public static List subTreesList (Tree t): calls subTree method, takes a collection and
finally returns a list of this collection.
public List compareTwoTree (List tList1, List tList2): during the matching phase, it
compares two tree lists member by member. This method has a kind of control in order
to shorten the matching time. For example, if a subtree is found during the matching the
source sentence, the system adds a (**) or it searches the subtree, but if the system
cannot find similar part of sentence in the database, it adds these subtrees in to the list
that is searched before.
public int compareTo (Tree t1, Tree t2): compares two trees leaf to node. This method is
a recursive function. It calls itself that has subt1, and subt2 as a parameter. subt1 is a
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child of t1 and subt2 is child of t2, so it compares all nodes of t1 and t2. It returns 0 if t1
and t2 are equal.
public int finishSearch (Tree t): controls whether all nodes have been found or not. The
system adds (**) in the node of source sentence tree if the system can makes a
translation perfectly. This means, the system found an English sentence with the same
structure and word in the database. This method is a recursive function. It calls itself so
the system can understand if the source sentence is translated.
public Tree searchSentence (Integer stSentID): This method takes one integer that uses
source of Sentence Tree and constructs a tree st and then builds stList with
subTreesList() that includes st’s subtree. Next it uses getSentenceIdArrayList() that
constitutes the list that included all sentenceIds in the EnglishSentence table.
Iteratively, the system takes one sentence in a tree with sentenceId in the
SentenceIdArrayList, and the system builds dtList. The system uses compareTwoTree
with stList and dtList. If the system finds equal subtrees (part of sentence) in the
compareTwoTree, system changes this part with corresponding Turkish part of sentence
by getTurkishSentenceTree. The system appends two stars (**) if a translation has
perfect meaning structure and leaves are equal, or the system adds one star (*) if only a
leaf is equal. If finishSearch returns a 0, then the system takes a new sentence from the
database with a new sentenceId in SentenceIdArrayList. This operation continues until
finishSearch returns 1 (translation is complete) or when SentenceIdArrayList is finished.
public Tree alignmentSentence(Tree t): Turkish sentence structure is different from
English sentence structure. Here, the system creates a tree which is suitable to the
English sentence structure. System must reorganize this tree for Turkish sentence
structure. For this purpose S-SSTC is used in ORHUN suitable to the Turkish sentence
during the translations. The system uses a basic rule for this process which will be
explained later with an example.
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public void translateEnglishToTurkish(Integer stSentID) : The system starts to translate
with translateEnglishToTurkish method. It calls searchSentence for mathing source
sentence to the database sentence and then searchSentence checks whether the
translation is a success. If translation is a success, searchSentence finishes the search and
returns a tree that includes Turkish sentence. If this tree is not null, this means that
translation is successful and it calls alignmentSentence method.
In the next section ORHUN system will be explained with an example, to show
how the system is executed and how the PCFG file for the parser is selected.
5.4 Interface of ORHUN
Firstly, user selects a PCFG file with “Load Parser” button and the ORHUN
system loads selected file for parsing an English sentence. Figure 5.11 and 5.12 show
this action.

Figure 5.11 Select PCFG file (englishPCFG.txt) for ORHUN system
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Figure 5.12 System loaded englishPCFG.txt as a parser file
Now the system starts to translate the English sentence to the Turkish one.
Firstly, the system writes a sentence and parses it as shown in Figure 5.13.

Figure 5.13 “the young girl bought a blue dress” source sentence is parsed
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Then, user selects the searchSentence option from the menu. Accordingly, the
system selects English sentence from the database and compares it to the source
sentence. If the system finds a similar sentence or part of sentence, it takes the Turkish
sentence or part of the sentence that corresponds to the found sentence. These steps are
shown in Figure 5.14 and 5.15.

Figure 5.14. Start to searchDatabase on the menu
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Figure 5.15 Sample 1: Result of English sentence translation to Turkish sentence
Figure 5.15 shows that “The young girl bought a blue dress” corresponds to “Genç
kız bir mavi elbise aldı”. During the translation process, the system has found 5 similar
sentences and selected the most suitable one.
Figure 5.16 shows another example of the system. Here, “Click a button in the
Categories box” corresponds to “Kategoriler kutusunda bir düğme tıklayın”. During the
translation process, the system has found 5 similar sentences and selected the most
suitable one.
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Figure 5.16 Sample 2: Result of English sentence translate to Turkish sentence

5.5 Tests and Evaluation
In this works 139 different sentences is inserted into the EnglishSentence table
and the corresponding sentences in the TurkishSentence table. Appendix A includes our
corpus that is built similar sentences. Number of perfect translations is satisfactory but
generally it is thought that this success depends on the corpus. It is expected that, if the
number of examples are increased, the success ratio will also increase. Additionally, if
ORHUN can’t make a perfect translation, it will translate the source sentence word by
word that corpus has those words. Thus, it will be understood what the sentence means,
in anyway.
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CHAPTER VI

CONCLUSION AND FUTURE WORK

In this thesis, Synchronous Structured String-Tree Correspondence (S-SSTC)
system has been developed to perform EBMT between English and Turkish languages.
EBMT methodology uses sentences or parts of sentences that were translated beforehand
which are stored as a corpus of translated sentences. The developed software uses SSTC
for the storage of the sentence information.
The system uses S-SSTC for the translation between the source language (English)
and the target language (Turkish), since the structure tree used by this methodology
provides flexibility for the Turkish grammar structure. In the translation phase, ORHUN
aims to produce readable translations without emphasizing the grammatical differences
between the two languages. Using simple rules for alignment, the system can produce
perfect translations. In the literature survey, only one working system between English
to Malay languages was found which used the same methodology; consequently this
methodology has been applied for the first time between English and Turkish languages.
One of the most important components of ORHUN is the corpus. If the corpus is
built with similar sentences in source language, system success rate decreases
dramatically. If the corpus is limited to a certain topic, the system provides more
effective results. For example, a corpus can be created which only relates with medicine,
or computer programming, as the sentences in the same topic generally have the same
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structure and terminology. Thus, given a corpus on medicine, if there is a sentence about
one illness, there probably will be a similar sentence about another illness.
Consequently, developing a corpus about a topic will enable us to translate any manual
or text book related with that topic. In addition to this, The system performance can
improve by a lot of database techniques. For example if the system uses index on the
database tables, system performance will be increase.
The most difficult problem encountered in this thesis is finding a Turkish parser.
After analyzing all the Turkish parsers available, suitable application cannot be found
for our software. Therefore, the Turkish sentence trees used by ORHUN had to be
created manually. For this reason, the example translations provided in the corpus of the
system were minimal. In the future work, the corpus can be enlarged to provide other
examples, and other corpuses can be built on other topics. If a powerful Turkish parser is
built, the problem of developing large English-Turkish example corpuses will be easily
solved. The ORHUN EBMT system can also be extended to include other grammatical
structures such as compound sentences, tenses, etc. Different EBMT methodologies
could be tested on the same corpus to analyze which methodology provides the best
result in English and Turkish translation. Finally as a future work, languages other than
English as the source language could be chosen to provide translation into Turkish.
Nowadays, especially with the enormous impact of the Internet, a large amount of
translation from English to Turkish is needed. The quality of the translation on these
documents is not very important, yet the time required for the translations has to be
minimal. Providing easy, quick and readable translations on the Internet will especially
be helpful to Turkish speaking users of the Internet to access any document in English.
The ORHUN system developed for this thesis provides an initial step to fast and easy
translation between English and Turkish.
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APPENDIX A
CORPUS
Add margins for binding

Ciltleme için kenar boşlukları ekleyin.

Click a category in the Categories box

Kategoriler kutusunda, bir kategoriyi tıklatın.

Click a paper size

Bir sayfa boyutu tıklatın

Click Assign

Ata'yı tıklatın.

Click Close

Kapat'ı tıklatın.

Click Create New.

Yeni Oluştur'u tıklatın.

Click Footnotes or Endnotes.

Dipnotlar veya Sonnotlar'ı tıklatın.

Click Heading number to insert the Bölüm
chapter number, and then click Insert.

numarası

eklemek

için

Başlık

numarası seçeneğini ve sonra Ekle'yi tıklatın.

Click Heading text to insert the chapter Bölüm başlığı eklemek için Başlık metni
heading, and then click Insert.

seçeneğini ve sonra Ekle'yi tıklatın.

Click in the document where you want Belge
to insert the AutoText entry.

içinde

Otomatik

Metin

girişini

eklemek istediğiniz yeri tıklatın.

Click in the section for which you want Farklı üstbilgi veya altbilgi oluşturmak
to create a different header or footer.

istediğiniz bölümü tıklatın.

Click Insert, and then click Close

Ekle'yi tıklatın ve sonra Kapat'ı tıklatın.

Click Insert, point to Reference, and Ekle'yi tıklatın, Başvuru'yı işaret edin ve
then click Footnote.

Dipnot'u tıklatın.

Click New.

Yeni'yi tıklatın.

Click OK.

Tamam'ı tıklatın.
Sayfa sonu'nu tıklatın ve sonra Tamam'ı

Click Page break, and then click OK.

tıklatın.

Click Portrait or Landscape

Dikey'i veya Yatay'ı tıklatın.

Click Remove.

Kaldır'ı tıklatın.

Click Run.

Çalıştır'ı tıklatın.
Yakınlaştırma kutusunun yanındaki oku

Click the arrow next to the Zoom box.

tıklatın

Click the Commands tab.

Komutlar sekmesini tıklatın.

Click the Layout tab.

Düzenleme sekmesini tıklatın.

Click the name of the AutoText entry İstediğiniz Otomatik Metin girdisinin adını
you want.

tıklatın.

Click the Options tab.

Seçenekler sekmesini tıklatın.

Click the Toolbar Options arrow

Araç Çubuğu Seçenekleri okunu tıklatın.
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Görüntülemek istediğiniz araç çubuğunu
Click the toolbar you want to display.

seçin.

Click the Toolbars tab.

Araç Çubukları sekmesini tıklatın

Click to the left of the index, table of
authorities, or table of figures that you Silmek istediğiniz dizin, kaynakça veya
want to delete.

şekiller tablosunun soluna tıklatın.

Click to the left of the index, table of Güncelleştirmek

istediğiniz

dizinin,

authorities, or table of figures that you kaynakçanın veya şekiller tablosunun solunu
want to update.

tıklatın.

Click where you want the items to be Öğenin
pasted.

yapıştırılmasını

istediğiniz

yeri

tıklatın.

Click where you want the reference Başvurunun yerleşmesini istediğiniz yeri
located.

tıklatın.

Click where you want to insert a
section break.

Bölüm sonu eklemek istediğiniz yeri tıklatın.

Create the header or footer for the first Belgenin veya bölümün ilk sayfası için
page of the document or section.

üstbilgi veya altbilgi oluşturun.

Footnotes and endnotes appear at the Dipnotlar ve sonnotlar Web sayfasının
end of the Web page.

sonunda görünür.

For Help on an option, click the
question mark , and then click the Bir seçenek hakkında Yardım için, soru
option.
Format

işaretini ve sonra seçeneği tıklatın.
the

new

reference

as Yeni

superscript

başvuruyu

üst

simge

olarak

biçimlendirme

Formatting inconsistencies will be Biçimlendirme tutarsızlıkları mavi dalgalı alt
marked with blue, wavy underlines.

çizgiler olarak işaretlenecektir.

I can't see the note pane at the bottom
of the page.

Sayfa sonunda not bölmesini göremiyorum.

In the Apply to box, click Selected text. Uygula kutusundaki Seçili metin'i tıklatın.
In the box to the right, click the name Sağdaki kutudan komutun adını veya diğer
of the command or other item.

öğeyi tıklatın.

In the browser, custom note separators Tarayıcıda, özel not ayırıcıları kısa yatay
appear as short horizontal lines.

çizgiler olarak görünür.

In the Categories box, click a category Kategoriler
for the command

kutusunda,

kategori seçin.
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komut

için

bir

In the Categories box, click Built-in Kategoriler kutusunda, Yerleşik Menüler'i
Menus.

tıklatın.

In the Categories box, click the
category that contains the command or Kategoriler kutusundan komutu veya diğer
other item.

öğeyi içeren kategoriyi tıklatın.

In the document, rest the pointer on the Belgenin içinde, işaretçiyi not başvuru
note reference mark.

işaretinin üzerinde tutun.

In the For which box, click the note to Hangisi kutusundan başvurmak istediğiniz
which you want to refer.

notu tıklatın.

In the Gutter box, enter a value for the Cilt Payı kutusuna kenar boşluğu için bir
gutter margin

değer girin.

In the Gutter position box, click Left or Cilt payı yeri kutusu içinde, Sol veya Üst'ü
Top.

tıklatın.
Başvurulacak

ekle

kutusundan

Dipnot

In the Insert reference to box, click numarası seçeneğini veya Sonnot numarası
Footnote number or Endnote number.

seçeneğini tıklatın.

In the Insert reference to box, select
what you want to insert in the header or Başvuru ekle kutusunda, üstbilgiye ve
footer.
In

the

altbilgiye ne eklemek istediğinizi seçin.
Macro

name

box,

click Makro adı kutusunda Liste Komutları'nı

ListCommands.

tıklatın.

In the Macros in box, click Word Makro yeri kutusunda Word komutları'nı
commands.

tıklatın.

In the Name box, enter the sound you
want.

Ad kutusunda, istediğiniz sesi girin.

In the note pane, click All footnotes or Not bölmesinde, Tüm dipnotlar veya Tüm
All endnotes.

sonnotlar seçeneğini tıklatın.

In the Number format box, click the Rakam
option you want.

biçimi

istediğiniz

seçeneği tıklatın.

In the Reference type box, click Başvuru türü
Footnote or Endnote.

kutusundan

kutusundan Dipnot veya

Sonnot'u tıklatın.

In the Sound Events box, click the Ses

Özellikleri

kutusunda,

istediğiniz

event you want.

özelliği tıklatın.

In the Style type box, click Character.

Stil türü kutusunda Karakter'i tıklatın.

In the Style type box, click List.

Stil türü kutusunda Liste'yi tıklatın.
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In the Style type box, click Paragraph.

Stil türü kutusunda Paragraf'ı tıklatın.

In the Style type box, click Table.

Stil türü kutusunda Tablo'yu tıklatın.

In the Styles and Formatting list, click Stiller ve Biçimlendirme listesinde, Dipnot
Footnote

Reference

or

Endnote Başvurusu'nu veya Sonnot Başvurusu'nu

Reference.

tıklatın.

In the Styles and Formatting task pane, Stiller ve Biçimlendirme görev bölmesinde,
click Custom in the Show box.

Göster kutusundaki Özel'i tıklatın.

In the Toolbar name box, type the Araç çubuğu adı kutusunda, istediğiniz yeni
name you want, and then click OK

bir adı yazın ve sonra Tamam'ı tıklatın.

In your document, right-click the blue, Belgenizde

biçimlendirme

tutarsızlığının

wavy underline where a formatting olduğu yeri gösteren mavi, dalgalı alt çizgiyi
inconsistency has occurred.

sağ tıklatın.

Make your changes to the header or Üstbilgi veya altbilgideki değişikliklerinizi
footer.

uygulayın.

Many accessibility features are built Birçok
right into Microsoft Word.

erişilebilirlik

özelliği

Microsoft

Word'de hazır bulunmaktadır.

Many features and commands are Birçok özellik ve komut doğrudan klavye
available directly from the keyboard.

aracılığıyla kullanılabilir.

Margins of the left page are a mirror Sol sayfanın kenar boşluğu ayarları sağ sayfa
image of those on the right page.

ayarlarının yansımasıdır.

Microsoft Word offers several page Microsoft
margin options.

Word'de

sayfa

kenar

boşluğu seçenekleri vardır.

My footnotes are getting renumbered in Dipnotlarım
my table.

çeşitli

tablomda

yeniden

numaralandırılıyor.

Note text does not appear with the
separator.

Not metni, ayırıcıyla birlikte görünmez.

On the Customize dialog box, click Özelleştir

iletişim

kutusunda,

Close.

tıklatın.

On the File menu, click New.

Dosya menüsünden Yeni'yi tıklatın.

On the File menu, click Print.

Dosya menüsünden Yazdır'ı tıklatın

On the File menu, click Print.

Dosya menüsünden Yazdır'ı tıklatın.

Kapat'ı

On the Format menu, click Reveal Biçim menüsünde, Biçimlendirmeyi Göster'i
Formatting.

tıklatın.

On the Header and Footer toolbar, click Üstbilgi ve Altbilgi araç çubuğundaki Sayfa
Page Setup

Yapısı'nı tıklatın.
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On the Insert menu, click Break.

Ekle menüsünde Kes'i tıklatın.

On the Insert menu, point to Reference, Ekle menüsündeki Başvuru'yu seçin ve
and then click Cross-reference.

Çapraz Başvuru'yu tıklatın.

On the Insert menu, point to Reference, Ekle menüsündeki Başvuru'nun üzerine gelin
and then click Footnote.

ve Dipnot'u tıklatın.

On the Insert menu, point to Reference, Ekle menüsünden Başvuru'nun üzerine gelin,
click Index and Tables, and then click Dizin
the tab you want.

ve

Tablolar'ı,

sonra

istediğiniz

sekmeyi tıklatın.

On the Standard toolbar, click New Standart araç çubuğunda, Yeni Boş Belge'yi
Blank Document

tıklatın.

On the Tools menu, click Customize.

Araçlar menüsünde, Özelleştir'i tıklatın.

On the Tools menu, click Options, and Araçlar menüsünde Seçenekler'i tıklatın ve
then click the View tab.

sonra Görünüm sekmesini tıklatın.

On the View menu, click Footnotes.

Görünüm menüsünden Dipnotlar'ı tıklatın.

On the View menu, click Header and Görünüm menüsünden Üstbilgi ve Altbilgi'yi
Footer.

tıklatın.
Görünüm menüsünde, Araç Çubukları'nın

On the View menu, point to Toolbars.

üzerine gidin.

Page margins are the blank space Kenar boşlukları, sayfa kenarlarındaki boş
around the edges of the page.

alanlardır.

Part of the footnote got moved to the Dipnotun bir bölümü bir sonraki sayfaya
next page.

taşındı.

Place the insertion point in the section Ekleme

noktasını,

biçimini

değiştirmek

in which you want to change the istediğiniz sonnotun veya dipnotun olduğu
footnote or endnote format.

bölüme yerleştirin.
Kutunun sol veya sağ köşesinin üzerine

Point to the left or right edge of the box gidin.
Select the Automatically update check Otomatik olarak güncelleştir onay kutusunu
box.

seçin.

Select the first instance of formatting Karşılaştırmak istediğiniz ilk biçimlendirme
you want to compare.

örneğini seçin.

Select the first item you want to copy.

Kopyalamak istediğiniz ilk öğeyi seçin.

Select the grammar and style rules used Dilbilgisi denetimi sırasında kullanılacak
during a grammar check.

dilbilgisi ve stil kurallarını seçebilirsiniz.

Select the pages that you want to Dikey veya yatay yönlendirmek istediğiniz
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change

to

portrait

or

landscape sayfaları seçin.

orientation.
Select the separator and make changes. Ayırıcıyı seçin ve değişiklikleri yapın.
Select the text whose formatting you Biçimlendirmesini görmek istediğiniz metni
want to review.

seçin.

Select the text you want to change.

Değiştirmek istediğiniz metni seçin.

Size and zoom options

Boyut ve yakınlaştırma seçenekleri

Some of the footnotes or endnotes have
disappeared.

Bazı dipnot veya sonnotlar yok oldu.

Superscript formatting is applied to the Üst
footnote.

simge

biçimlendirmesi

dipnota

görünümdeyseniz,

normal

uygulanır.

Switch to normal view if you are in a Farklı

bir

different view.

görünüme geçin.

Switch to normal view.

Normal görünüme geçin.

Switch to print layout view or Web Yazdırma düzeni görünümüne veya Web
layout view.

düzeni görünümüne geçin.

The following procedure creates a new, Aşağıdaki yordam yeni, boş bir belge
blank document.

oluşturur.

The formatting information will appear Biçimlendirme
in the Reveal Formatting task pane.

bilgileri

Biçimlendirmeyi

Göster görev bölmesinde belirecektir.

The grammar checker may not look for
all types of problems; it's designed to
focus on those that are most typical or Yazım denetleyicisinde olduğu gibi, içerik
frequent.

olarak farklı terimler bulunabilir.

The new default settings are saved in
the template on which the document is Yeni varsayılan ayarlar belgenin dayandığı
based.

şablon içine kaydedilir.

The note text appears above the mark Not metni bir Ekran İpucu'ndaki işaretin üst
in a ScreenTip.

kısmında görünür.

The note text appears above the mark.

Not metni, işaretin üzerinde görünür.

The pointer shape indicates how the İşaretçinin
item will be formatted.
These

features

everyone,

are

without

şekli

öğenin

nasıl

biçimlendirileceğini gösterir.
available
the

additional accessibility aids.

need

to Bu

özellikler

for gerekmeksizin
kullanılabilir.
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ek erişilebilirlik
herkes

yardımı
tarafından

To add the new style definition to your
template, select the Add to template Şablonunuza yeni stil tanımını eklemek için,
check box.

Şablona ekle onay kutusunu işaretleyin.

To create a header, enter text or Üstbilgi oluşturmak için üstbilgi alanına
graphics in the header area.

metin veya grafik girin.
Minimum

kenar

To determine the minimum margin belirlemek için,
settings, check your printer manual.

boşluğu

ayarlarını

yazıcınızın el

kitabını

inceleyin.

To edit the separator, insert a Clip Art Ayırıcıyı düzenlemek için, Küçük Resim
divider line or type text.
To

remove

the

separator,

ayırıcı çizgisi ekleyin veya metin girin.
press

DELETE

Ayırıcıyı kaldırmak için, DELETE'e basın.

To restore the default separator, click Varsayılan ayırıcıyı geri yüklemek için,
Reset.
To

view

Sıfırla'yı tıklatın.
more

toolbars,

click Daha fazla araç çubuğu görüntülemek için,

Customize.

Özelleştir'i tıklatın.

Under Editing options, select or clear Düzenleme

seçenekleri

altında,

the Keep track of formatting check Biçimlendirmeyi izle onay kutusunu seçin
box.

veya temizleyin.
Düzen

seçeneklerinin

altındaki

Under Editing options, select the Mark Biçimlendirme tutarsızlıklarını işaretle onay
formatting inconsistencies check box.

kutusunu işaretleyin.

Under Formatting, select the options Biçimlendirme'de
you want.

Boşlukları

altında,

istediğiniz

seçenekleri belirleyin.

Under Orientation, click Portrait or Yönlendirme'nin
Landscape.

seçeneği

belirleyin.

Under Margins, select the options you Kenar
want.

istediğiniz

altındaki

Dikey

veya

Yatay'ı tıklatın.

Under Page range, specify the portion Sayfa aralığı altında belgenin yazdırmak
of the document you want to print.

istediğiniz kısmını belirtin.

Under Styles, click the style you want Stil'den, değiştirmek istediğiniz stili ve sonra
to change, and then click Modify.

Değiştir'i tıklatın.

Use portrait and landscape orientation Aynı belgede dikey ve yatay yönlendirme
in the same document

kullanma

View footnotes and endnotes in a Microsoft Word belgesi içindeki dipnotları
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Microsoft Word document

ve sonnotları görüntüleme

Word shares custom dictionaries with Word bu sözlükleri diğer Microsoft Office
other Microsoft Office programs.

programlarıyla paylaşır.

You can also use keyboard shortcuts to Yakınlaştırmak için klavye kısayollarını da
zoom.

kullanabilirsiniz.

You can customize color and sound Renk
options

ve

ses

seçeneklerini

özelleştirebilirsiniz.

You can customize separators by Kenarlıklar, metin veya grafikler ekleyerek,
adding borders, text, or graphics.

ayırıcıları özelleştirebilirsiniz.

You can customize toolbars and menu Araç çubuklarını ve menü komutlarını
commands

özelleştirebilirsiniz.

You can customize Word to better suit Word'ü ihtiyaçlarınıza daha iyi karşılık
your needs

verecek şekilde özelleştirebilirsiniz

You can even create a custom toolbar Ayrıca özel araç çubuğu düğmeleri ve menü
button or menu command

komutları da oluşturabilirsiniz.

You might use footnotes for detailed
comments and endnotes for citation of Dipnotları detaylı açıklamalar, sonnotları ise
sources.

kaynakları belirtmek için kullanabilirsiniz.

You must delete the note reference Nota ilişkin not başvuru işaretini silmeniz
mark that corresponds to the note.

gerekmektedir.
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APPENDIX B
public boolean isLeaf() { return false;}
public boolean isPhrasal() { return false;}
public boolean equals(Object object) { return false;}
public int compareTo(Object object) { return 0;}
public int indexOf(Tree tree) { return 0;}
public List getChildrenAsList() { return null;}
public void setChildren(Tree[] treeArray) { }
public void setChildren(List list) { }
public Label label() { return null;}
public void setLabel(Label label) { }
public Tree firstChild() { return null;}
public Tree lastChild() { return null;}
public StringBuffer toStringBuffer(StringBuffer stringBuffer) { return null;}
public String toString() { return null;}
public String nodeString() { return null;}
public void pennPrint(PrintWriter printWriter) { }
public void pennPrint(PrintStream printStream) { }
public void pennPrint() { }
public int depth() { return 0;}
public Sentence yield() { return null;}
public List yield(List list) { return null;}
public Collection labels() { return null;}
public List subTreeList() { return null;}
public Collection subTrees(Collection collection) { return null;}
public Tree deepCopy() { return null;}
public Tree deepCopy(TreeFactory treeFactory) { return null;}
public static Tree valueOf(String string) throws IOException { return null;}
public void insertDtr(Tree tree, int _int) { }
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